
 

Palaeontologia Electronica 
http://palaeo-electronica.org

Purnell, Mark, A. 2003. Casting, Replication, and Anaglyph Stereo Imaging of Microscopic Detail in Fossils, with Examples From 
Conodonts and Other Jawless Vertebrates. Palaeontologia Electronica 6(2):11p, 419KB; http://palaeo-electronica.org/paleo/2003_2/
rubber/issue2_03.htm

CASTING, REPLICATION, AND ANAGLYPH STEREO IMAGING OF 
MICROSCOPIC DETAIL IN FOSSILS, WITH EXAMPLES FROM 

CONODONTS AND OTHER JAWLESS VERTEBRATES

Mark A. Purnell

ABSTRACT

Sophisticated techniques, such as computed tomography and scanning light
microscopy, now allow palaeontologists to image the microscopic details of fossils
even when scanning electron microscopy cannot be used. Occasionally these tech-
niques are not always applicable, and where this is the case, methods involving fossil
replication offer an alternative. I describe here a series of techniques for moulding,
casting, imaging, and three-dimensional illustration of microfossils (or microscopic
details of larger fossils). For moulding fossils (or casting mouldic specimens), room
temperature vulcanizing silicon rubber provides a strong and flexible medium with low
levels of shrinkage. RTV rubbers are also capable of replicating microscopic details of
only a few micrometres. Similarly, epoxy resins are rigid, durable, and long lasting. In
combination with RTV silicon rubber moulds, epoxy casts offer higher levels of resolu-
tion than any other medium. Details of specific RTV rubbers and epoxy resins that are
widely available and work well with small fossils are provided.

For imaging, the advantages of stereophotography to illustrate fossils have long
been appreciated, but the use of stereo-pairs is limited by their maximum size (gener-
ally only 5 or 6 centimetres). With the widespread availability of powerful image editing
software, it is now a straightforward matter to produce anaglyph stereo images of any
size. I provide step-by-step instructions and a set of actions to automate the process in
Adobe Photoshop®. Anaglyph stereo images can be extremely useful research tools in
their own right, but combined with electronic communication and publication they offer
a simple and inexpensive means for illustrating fossils, and their microscopic details, in
three-dimensions.
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INTRODUCTION

Despite advances in recent years, microfos-
sils, or small details on larger fossils, can be diffi-
cult to image. Advances include: equipment that
allows routine scanning electron microscopy with-
out the need to coat specimens with conductive
materials; techniques such as scanning light
microscopy (Scott et al. 2000) and extended focus
image montage methods (e.g., Holbourn and
Henderson 2002; Knappertsbusch 2002) that are
able to overcome the depth of field limitations of
optical photomicrography; high resolution colour
laser scanning (Lyons et al. 2000) and computed
tomography (Rowe 1996; Brochu 2000). These
techniques and methods are increasingly applied
to palaeontological problems, yet there are still
instances when availability of equipment, cost con-
siderations, or the nature of the material under
investigation mean that direct imaging using these
techniques is impractical or impossible. I describe
here a series of simple and inexpensive methods
for specimen preparation and replication that allow
for high resolution imaging of microscopic details in
such instances. I also describe a simple and rapid
process for producing anaglyph stereo images,
and provide a set of Adobe Photoshop® actions for
partial automation of this process. Except in some
details, none of these techniques is new. The pur-
pose of this paper is to highlight their usefulness in
palaeontological research and communication,
especially in dealing with microscopic subject mat-
ter, to provide specific details of methods and
widely available materials that have been found to
work well, and to illustrate with examples from con-
odonts and other jawless vertebrates how they can
reveal important detail that is otherwise unobtain-
able. It is worth emphasizing that before applying
any of these methods to borrowed material, full
permission should obtained.

Silicon Rubber Moulding

For most palaeontological applications, the
choice of moulding material is between latex-and
silicon-based compounds. Latex rubber solution is
still in common use by palaeontologists and is suit-
able for many purposes, but it has the major disad-
vantage of shrinkage (Goodwin and Chaney 1994).
Silicon-based materials, especially room tempera-
ture vulcanising (RTV) silicon rubbers, on the other
hand, have lower levels of shrinkage and also offer
other advantages over latex, including strength,
flexibility, (Goodwin and Chaney 1994), and, once
cured, good shelf-life stability (although some are
susceptible to degradation by ozone and UK light,
so storage in a dark, anoxic environment will maxi-

mise shelf life). Silicon rubbers also have the capa-
bility of capturing details at the submicrometre level
(Rose 1983). Latex moulds have poor resistance to
epoxy and polyester resins, and a parting agent
must be used to protect the mould (Goodwin and
Chaney 1994). Consequently, methods using latex
moulds with resin cannot replicate microscopic
details.

The use of room temperature vulcanizing sili-
con rubbers (and epoxy casting – see below) in
palaeontology was pioneered by Waters and Sav-
age (1971) and is now widespread. Waters and
Savage (1971) and more recent publications (e.g.,
Reser 1981; Chaney 1989; Goodwin and Chaney
1994) cover the general methodology of mould
making and contain details of precautions that will
ensure that use of RTV silicon rubbers causes no
damage to either the fossil or the humans involved.
The focus of this paper, however, is moulding and
casting microscopic detail, and although Waters
and Savage (1971), for example, replicated micro-
mammal remains down to a few millimetres in size,
the use of silicon rubber to mould smaller fossils,
including microfossils, has been limited. Chaney
(1989) attempted to mould forams, but had only
partial success, whereas Siveter (1984), obtained
good results using RTV rubber to cast the fine
details of ostracods preserved as natural moulds.
Some of the methods presented here have devel-
oped from those of Siveter (1984).

The basic steps of the process as I have
applied it are as follows. Prior to moulding, the sur-
face of the specimen is coated with a thin layer of
separator (or consolidant) or a release agent. This
layer serves several purposes: it prevents loose
parts of the specimen from being pulled off when
the cured mould is removed; it prevents silicon fluid
from penetrating the surface of the specimen and
leaving a dark stain (particularly important if the
specimen preserves traces of soft tissue remains);
and it improves the chances of removing the cured
mould cleanly from the specimen without leaving
torn-off fragments of rubber in undercuts and the
deeper recesses of the specimen. A solution of pvb
[a terpolymer of poly(vinylbutyral), poly(vinyl alco-
hol), and poly(vinyl acetate)] in methanol has been
found to be an effective consolidant and separator,
which has the advantages of being safe, stable,
and reversible (Elder et al. 1997). The solution is
easily prepared to the right consistency to allow
good impregnation of the surface without overglaz-
ing and obscuring morphological details. If applied
too thickly, excess consolidant can be removed or
redistributed by brushing methanol over the sur-
face. Determining how much separator is required
to protect the specimen without obscuring detail is
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a matter of judgement and experience, but if
patches of the dried separator on the surface of the
specimen appear smooth and shiny, it is probably
too thick. Chaney (1989) suggested that use of a
separator prevents the mould from picking up
microscopic detail, but I have found that if the coat-
ing is thin enough, the mould can pick up details
down to a few tens of micrometres or less (see
examples below, especially example 3). Neverthe-
less, if the specimen will allow it, maximum detail
will be obtained if no separator is used. It is worth
noting here that in selecting a separator, reversibil-
ity is a particular important property. Materials with
questionable or limited reversibility should be
avoided as they may be difficult to remove from the
specimen.

A release agent may be used instead of, or in
addition to, a consolidant or separator. In itself this
release agent will do little to stabilise the surface of
the specimen, but it will reduce or prevent penetra-
tion of silicon fluid and facilitate clean removal of
the cured mould. A 50% solution of domestic dish-
washing detergent (washing-up liquid) in water
makes an effective release agent that does not
obscure surface details. A thin coat can be painted
onto the specimen with a soft brush and left to dry
before moulding.

In most cases, the area of the specimen to be
moulded will need to be surrounded by a wall to
prevent silicon rubber from flowing away over the
surface of the specimen. A variety of materials are
suitable for this purpose. Non-curing modelling
clay, such as plasticene, is widely available and
easy to use, although dark colours may stain the
surface of pale specimens, and silcone rubber may
adhere to some clays (see Goodwin and Chaney
1994). For walls surrounding small areas, rapid
curing two part vinyl polysiloxane rubbers designed
for dental applications, such as Colténe Presi-
dent, can be very effective in forming mould walls
although they tend to be expensive.

As for the moulding material itself, many dif-
ferent RTV rubbers are available from a number of
manufacturers and suppliers, and the choice of
rubber will depend to some extent on the nature of
the specimen and the mould required. For mould-
ing microscopic details of fossils, however, the
uncured rubber will need to be of low viscosity, and
the cured rubber should have a high elongation at
break and high tear strength. These attributes will
maximize the chances of removing the mould
cleanly from the fossil without leaving torn-off frag-
ments stuck in the deeper recesses and undercuts
(which can be very difficult to remove without caus-
ing damage). When dealing with fragile material,
however, high tear strength rubbers can increase

the possibility of damage to the specimen because
the specimen may break before the rubber tears,
so careful consideration of the properties of the
cured rubber is important. Having tried a number of
different rubbers, I have had good results with a
product sold as Ambersil RTV913 in the UK (manu-
factured by Ambersil Silicones) or as QM113 in
North America (Quantum Silicones, www.quantum-
silicones.com). Distributors in other parts of the
world are listed on the UK manufacturers website
(www.amberchemical.com). This rubber is a two
component room temperature condensation cur-
ing silicone compound. The cured rubber is very
flexible and has good shelf-life stability. Full details
of the physical properties are available from
Ambersil (www.ambersilsilicones.com), but the
important attributes are as follows (manufacturers
data): viscosity of base compound approximately
15,000 MPa.s (MilliPascal seconds; the viscosity of
the compound with catalyst added is slightly less);
linear shrinkage < 0.5%, tensile strength of cured
rubber, 3.1 Mpa; elongation at break, 650%; tear
strength 22 kN/m. The potlife of the catalysed rub-
ber (i.e., the working time for mould pouring) is
approximately 45 minutes.

The rubber is mixed according to the manu-
facturers instructions, taking appropriate precau-
tions for the safe handling of the materials (see
health and safety information below). Optical imag-
ing of the mould may be desirable, in which case
black pigment (e.g. Aniline Black or Lamp Black)
can be added to the rubber at the same time as the
catalyst. After mixing, placing the rubber under
vacuum for a few minutes can reduce the number
of bubbles, but when applying rubber as outlined
here I have not found this step to be necessary. All
the examples presented below have used Ambersil
RTV913. 

The quality of the final mould depends to a
large extent on the way in which the catalysed liq-
uid rubber is applied to the specimen. The best
results are achieved by trickling a small amount of
rubber down the side of the wall or onto the speci-
men, and allowing it to flow slowly over the surface,
so that the rubber creeps over the specimen, and
is pulled into details and recesses by surface ten-
sion and capillary action. If the advancing edge of
the rubber is allowed to bulge outwards and “roll”
over the surface of the specimen there is a high
probability that air bubbles will be trapped in fine
details and recessed areas. Using a mounted nee-
dle or something similar to gently pull back the
advancing edge of the rubber, taking care not to
contact the surface of the specimen, can slow the
rate of advance and prevent the edge from rolling
over. The rate of flow is also much easier to control
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if liquid rubber is added in small increments. Cured
RTV913 is very flexible and lacks rigidity. For small
specimens or moulds this flexibility does not
present a problem, but larger moulds may require a
rigid supporting jacket (or mother mould), or addi-
tion of a layer of stiffer RTV around the mould.

The next stage of preparation will depend on
the nature of the material, and whether it is the
mould of the specimen that is of interest or a rep-
lica of the original. In cases where rubber is being
used to cast a natural mould or a mould prepared
by acid preparation of a specimen (see Example
1), it will be the rubber cast itself that is of interest.
Once cured this rubber cast can be mounted and
coated for scanning electron microscopy using
standard methods (although because of the poor
conductivity of the rubber, longer coating times
may be required than for most specimens). If a rep-
lica of the original specimen is required (see Exam-
ples 2 and 3), an epoxy resin cast should be
prepared.

Epoxy Resin Casting

In making high resolution casts, the choice of
casting medium depends on a number of factors,
but for detailed replication of microscopic details on
small specimens, epoxy resins are ideal. Not only
are epoxy casts rigid and durable, their fidelity to
the mould is very high, better than any other mate-
rial (Chaney 1989), and they are stable over long
periods. They are also easily mounted and coated
for scanning electron microscopy. One factor that
should also be borne in mind is that not all resins
and moulding materials are compatible, and reac-
tions between the mould and the casting medium
can significantly reduce the quality of the cast. For
reviews of the problems relating to compatibility
between epoxies and silicon-based moulding com-
pounds in the context of reproducing tooth wear
facets and details of microwear see Gordon (1984)
and Teaford and Oyen (1989), or Bromage (1985)
for more general comments on replicas in scanning
electron microscopy. After the issue of compatibil-
ity, probably the most important factor in determin-
ing the quality of reproduction of microscopic detail
is the viscosity of the resin. Low viscosity resins
flow more easily into small recesses and are less
likely to trap air bubbles.

I have had good results with Araldite 2020, a
widely available two-component low-viscosity,
water-white epoxy adhesive which is also suitable
for casting (see Examples 2 and 3). Not only is the
viscosity low enough for epoxy to flow easily into
details of the mould, it is compatible with RTV 913,
yielding good quality casts with high levels of detail
(including features only a few micrometres or tens

of micrometres in size [see Example 3]). According
to the manufacturers technical support department,
casts in Araldite, if stored away from UV light,
should last at least 50 years, although projection
beyond that time is difficult (Noel Moss, Vantico
Ltd., personal commun., 2003).

The process of pouring an epoxy cast is simi-
lar to that for preparing a rubber mould outlined
above. The epoxy resin and catalyst are mixed
according to the manufacturers instructions, taking
appropriate precautions for the safe handling of the
materials (see health and safety information
below). The usable life of the catalysed epoxy is
about 45 minutes at 23°C (but note that the exo-
thermic reaction between catalyst and resin can
cause a rapid rise in temperature if large amounts
of resin are mixed, and this temperature increase
will accelerate curing). Small batches of epoxy
weighing only a few grams can be prepared if the
proportions of catalyst and resin are measured by
weight using scales of appropriate precision. The
catalysed epoxy is then trickled slowly into the
mould, or added drop by drop, and allowed to flow
slowly over the surface. The use of hand-driven
centrifuges is advocated in some discussions of
epoxy casting (e.g., Waters and Savage 1971), but
I have not found this step necessary when pouring
one-part moulds using Araldite 2020. The epoxy is
water clear, so if optical examination or imaging will
be required, pigment should be added to the resin
at the same time the catalyst is mixed in. Addition
and thorough mixing-in of Lamp Black or Aniline
Black pigment produces opaque black casts. Other
pigments suitable for epoxy may also be used. It is
worth noting that if the epoxy is coloured using a
solution of eosin stain in ethanol, the method of
Jernvall and Selänne (1999) can be used to
acquire high-resolution digital representations of
fossil shape through laser confocal microscopy
(although the effects of eosin solution on the cure
properties Araldite 2020 have not been tested). For
Scanning Electron Microscopy, it makes no differ-
ence whether the cast is pigmented or clear.

Health and Safety and RTV Rubber and Epoxy

Care must be taken, when using RTV rubbers
and epoxy resins, to follow manufacturer instruc-
tions regarding safe handling and storage. Some of
the components of RTV rubbers, epoxy resins and
their catalysts are toxic and/or irritants. Material
Safety Data Sheets (MSDS) for Ambersil RTV913
and other Ambersil products are available via the
Ambersil and Quantum Silicones websites
(www.ambersilsilicones.com, www.quantumsili-
cones.com). Instructions on how to obtain MSDS
for Araldite 2000 series epoxy resins are available
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from the distributors website (www.adhesives.van-
tico.com).

Stereo Anaglyph Images

Techniques for obtaining and publishing ste-
reo images of fossils, and especially small fossils,
are widely known in the palaeontological commu-
nity, and their greater use has been advocated by a
number of authors over the years (Evitt 1949;
Sylvester Bradley 1971). Conodonts were among
the first fossils to which stereophotographic meth-
ods were applied (Branson and Mehl 1933; Evitt
1949), yet with the exception of ostracods (Siveter
1984) stereo images are seldom employed to illus-
trate microfossils, or the microscopic details of
larger specimens. The standard approach is to
obtain two images of the fossil which differ in their
effective viewing angle by 8-10° (although 5° may
give better results when the depth of a specimen,
in the orientation being photographed, exceeds the
average width; Sylvester Bradley 1971). Optical or
digital stereo photomicrographs can be obtained
using simple tilting or sliding stages (Branson and
Mehl 1933; Feldman 1989); scanning electron
micrograph pairs are easily obtained by tilting the
specimen stage. Once obtained, the images are
reproduced side by side, with the axis of image
rotation aligned vertically between them, and
viewed using stereo viewers (see Feldman 1989
for details). This method can be very effective in
communicating three-dimensional (3D) geome-
tries of fossils, but the size of the images is limited,
and unless large format stereoscopic viewers are
used, the maximum width at which images can be
reproduced is only 5 or 6 centimetres (see
Sylvester Bradley 1971 for discussion).

What is perhaps less well known among
palaeontologists is that red-green or red-blue ana-
glyph images offer an alternative that with the
widespread availability of powerful image editing
software such as Adobe Photoshop® and Correl
Photopaint® are quick and simple to produce.
Images can be reproduced at any size (for printing,
viewing on screen, or even for projection in presen-
tations) and viewed in stereo with readily available
and inexpensive cardboard and plastic viewers
(with one red and one green lens, or one red and
one blue, depending on the chosen anaglyph for-
mat; viewers are available from scientific equip-
ment suppliers, or from the numerous potential
vendors that are revealed by a www search for “3D
glasses”). Stereo images produced in this way can
be extremely useful as research tools, for commu-
nication via the Internet and email, and also for
publication. Reproduction of colour plates and fig-
ures is now more widespread and cheaper than in

the past, and is even made available at no addi-
tional cost by some journals.

Knappertsbusch (2002) recently outlined a
method combining digital stereo imaging through
an optical microscope with extended focus mon-
taging and QuickTime VR™ authoring to produce
animated anaglyph stereo images of microfossils.
He highlighted some of the advantages of anag-
lyph stereo images and considered aspects of ste-
reo image acquisition in some detail, but the paper
was focussed on a particular method, using rela-
tively expensive hardware. My goal here is to pro-
vide a simple guide to the production of anaglyph
images using widely available equipment and soft-
ware.

The exact method of producing anaglyph ste-
reo images varies according to the software pack-
age used, but Appendix 2 to this paper includes
step-by-step guides to producing images using
Adobe Photoshop®. A set of actions that will auto-
mate much of the process in Photoshop® is also
available for download. Producing anaglyph
images using software packages that do not sup-
port image layers is less intuitive, but a www
search for “analglyph” brings up instructions for
many common digital imaging or photo editing
packages that should be readily applicable to
palaeontological images.

EXAMPLES OF APPLICATION OF SILICON 
RUBBER CASTING, EPOXY REPLICATION, 

AND STEREO IMAGING

Example 1: Silicon Rubber Casting of Acid 
Prepared Mould of a Natural Assemblage of 

Distomodus

Specimen BGS MWL 4702 preserves a partial
skeleton of a conodont, but the identity of the taxon
could not be determined because the P elements
were exposed on a slab of black shale with their
lower surface uppermost. The taxonomically diag-
nostic features of the elements were facing down-
wards, embedded in the matrix. After taking a
silicon rubber mould to preserve a record of the
surface of the specimen, it was prepared by care-
fully dissolving the phosphatic crown tissue of the
elements in 10% hydrochloric acid. When dry the
surface was consolidated with pvb in methanol,
and a cast of the external mould of the elements
made using RTV 913. After curing, the rubber cast
was removed, mounted and coated (with silver) for
scanning electron microscopy. Stereo pairs were
prepared by acquiring images of the specimen at
approximately –5 and +5 degrees relative to hori-
zontal. Red-green anaglyph stereo images (Figure
1) were prepared by the method outline above and
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detailed in Appendix 2. These images have been
used for primary research on the specimen (as the
only way of visualising details of the surface of the
P elements in 3D), for communication with col-
leagues and collaborators (email, presentations,
and reports), and for publication (Purnell et al.
2003).

Example 2. Acid Preparation, Consolidation, 
Silicon Rubber Moulding and Epoxy Casting of 

the Mouth of Protopteraspis vogti

Specimen A28720 (Paleontologisk Museum,
Oslo) was collected from the Devonian, Ben Nevis
Formation during the 1925 expedition to Spitzber-
gen. The slab preserves articulated remains of
several individuals of Protopteraspis vogti Kaier,
including two with articulated oral plates. Heterost-
racans preserving articulated oral plates are rare,
and the outer surface of one of the specimens on
the slab, A28720/2, was mechanically prepared to
expose the details of the mouth (by Anatol Heintz,
sometime between 1925 and 1930). The specimen
lies at an angle to the surface of the slab, and as a
result of the removal of material from the mouth the
exposed oral plates now sit within a steep-sided
recess, more than 1 cm deep (Figure 2). As part of
an investigation into the structure of the mouth of
pteraspid heterostracans (Purnell 2002, and ongo-
ing work with D. K. Elliot), detailed images of the

mouth were required.  The fact that the specimen
sits on a recess caused some difficulties, espe-
cially in trying to obtain scanning electron photomi-
crographs.

Additional acid preparation of the specimen
was carried out to remove carbonate rock matrix
from around the oral plates of the mouth using eth-
anoic acid (acetic acid), buffered according to the
method of Jeppsson et al. (1985). Areas of the
specimen which required no further preparation
were protected from the acid by a covering of pvb,
and as matrix was removed by acid dissolution,
newly exposed areas of the oral plates were also
covered with pvb. Prior to moulding, these protec-
tive coatings were removed, and a thin layer of pvb
was applied as a precautionary separator over the
area to be moulded (following the procedure out-
lined above).

Figures 2B and 2C shows scanning electron
images of an epoxy replica of the mouth of P.vogti
specimen A28720/2. The replica was cast using
Araldite 2020 in a mould of RTV913. The figure
shows the level of detail revealed by the acid prep-
aration and retained through the moulding and
casting process. Because the specimen sits in a
recess, the anterior view of the mouth (Figure 2C)
could not have been obtained by direct optical or
scanning electron microscope imaging.

Figure 1. Red-green anaglyph stereo image of RTV 913 cast of BGS MWL 4702, a partial skeleton of the conodont
Distomodus, showing oral surfaces of P elements. Scale bar 1 mm.
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Example 3: Acid Preparation, Consolidation, 
Silicon Rubber Moulding and Epoxy Casting of 
the Apparatus of Conodont Specimen RMS GY 

1992.41.2

National Museum of Scotland specimen RMS
GY 1992.41.2 is one of the 10 specimens from the
Granton Shrimp bed of Edinburgh that preserve
traces of soft tissue (Aldridge et al. 1993). Although
the exceptional preservation of body remains has
transformed the study of conodont palaeobiology,
studying the conodont elements in some of the
specimens has been rather problematic because of
the difficulties of preparing elements without dam-
aging soft tissue remains. In some cases it has not
been possible to assign a specimen to a taxon,
simply because the identity of the elements could
not be determined due to significant morphological
details being obscured by rock. Also, scanning
electron microscope imaging of elements in some
of the specimens has been prevented because the
blocks are too large.

Interpretation of specimen RMS GY
1992.41.2 has been hampered by both these prob-
lems. Aldridge et al. (1993 p. 420) noted that in this
specimen “The Pa element is not sufficiently
exposed to allow the taxon to be positively identi-
fied.” The conodont lies in the centre of a large
block of laminated, organic rich limestone (16-20
cm long, 9-12 cm wide, 8-9 cm thick), thus effec-
tively preventing imaging of the elements in a scan-
ning electron microscope.

In order to overcome these difficulties, acid
preparation of the P1 element ( = Pa, see Purnell et
al. 2000 for discussion of element notation) was
undertaken, using pvb to coat adjacent areas and
limit the effects of the acid to the area of the P1 ele-
ment only. Buffered nethanoic acid (formic acid),
prepared according to the method of Jeppsson and
Anehus (1995), was applied to the element and its
immediate surroundings drop by drop. The reaction
was constantly monitored under a binocular micro-
scope to ensure that the specimen was not
adversely affected in any way. The area under
preparation was washed periodically with deion-
ised water, and a fine paintbrush (00) and a very
fine flexible steel mounted needle (0.25 mm diame-
ter) were used to assist with the removal of the
matrix from around the element. After several
hours, the element was considered sufficiently well
exposed and, after washing, drying, and applica-
tion of a thin layer of pvb as a separator, a rubber
mould was made using RTV 913 contained with a
wall of Colténe® President following the method
detailed above. From this step an epoxy cast was
made using Araldite 2020 (see above).

Figure 3A shows an anaglyph stereo image of
the epoxy replica of the elements preserved in
specimen RMS GY 1992.41.2. The P1 element,
toward the left is now well exposed. The enlarge-
ments show the level of detail reproduced by the
replica, with incremental growth lamellae evident in
the basal cavity of the P1 (arrowed in Figure 3B)

Figure 2. Specimen A28720 (Paleontologisk Museum, Oslo) preserving articulated remains of the heterostracan Pro-
topteraspis vogti Kiaer (specimen A28720/2). A. Whole specimen showing the mouth of the heterostracan sitting with
the recess resulting from mechanical preparation to reveal the oral plates.  B. Montage of scanning electron photomi-
crographs of epoxy resin replica of the oral plates following acid preparation, consolidation, and silicon rubber mould-
ing.  C. Montage of scanning electron photomicrographs of epoxy resin replica, showing the oral plates in oblique
anterior view. Scale bar 1 mm.
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and along the lower margin of the S4 elements
(arrowed in Figure 3C).

CONCLUSIONS

Silicon rubber moulding, epoxy casting, and
anaglyph imaging provide effective, relatively sim-
ple and inexpensive techniques for the replication
and illustration of microscopic details of fossils,
details that for a variety of reasons may not be
amenable to study using other methods. The tech-
niques presented here indicate how to maximise
the level of detail that can be replicated and
imaged with minimum risk to the fossil. With the
widespread use of digital imaging, combined with
electronic communication and publication, anag-
lyph images offer a simple, inexpensive and
extremely effective means of illustrating fossils in
three-dimensions.
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the lower margin of the S4 ele-
ment (arrowed). Scale bar 0.5
mm.



PURNELL: CASTING MICROSCOPIC DETAIL

9

REFERENCES
Aldridge, R.J., Briggs, D.E.G., Smith, M.P., Clarkson,

E.N.K. and Clark, N.D.L. 1993. The anatomy of con-
odonts. Philosophical Transactions of the Royal Soci-
ety of London, Series B, 340:405-421.

Branson, E.B. and Mehl, M.G. 1933. Conodont studies,
number 1. University of Missouri Studies, 8:1-72.

Brochu, C.A. 2000. A digitally-rendered endocast for Tyr-
annosaurus rex. Journal of Vertebrate Paleontology,
20:1-6.

Bromage, T.G. 1985. Systematic inquiry in test of nega-
tive/positive replica combinations for SEM. Journal of
Microscopy, 137:209-216.

Chaney, D.S. 1989. Mold making with room temperature
vulcanizing silicone rubber, p. 284-304. In Feldman,
R.M., Chapman, R.E., and Hannibal, J.T. (eds.),
Paleotechniques, Paleontological Society Special
Publication no. 4., Knoxville, Tennesee.

Elder, A., Madsen, S., Brown, G., Herbel, C., Collins, C.,
Whelan, S., Wenz, C., S., A. and Kronthal, L. 1997.
Adhesives and consolidants in geological and pale-
ontological conservation: a wall chart. SPNHC Leaf-
lets: A Technical Publication Series of the Society for
the Preservation of Natural History Collection, 1:??

Evitt, W.R. 1949. Stereophotography as a tool of the
paleontologist. Journal of Paleontology, 23:566-570.

Feldman, R.M. 1989. Preparation of stereoscopic photo-
graphs, p. 347-350. In Feldman, R. M., Chapman,
R.E., and Hannibal, J.T. (eds.), Paleotechniques,
Paleontological Society Special Publication no. 4.
Knoxville, Tennesee.

Goodwin, M. B. and Chaney, D. S. 1994. Molding and
casting: techniques and materials, p. 235-271. In
Leiggi, P. and May, P. (eds), Vertebrate Paleontologi-
cal Techniques: Volume one. Cambridge University
Press, Cambridge.

Gordon, K.D. 1984. Pitting and bubbling artifacts in sur-
face replicas made with silicone elastomers. Journal
of Microscopy, 134:183-188.

Holbourn, A.E. and Henderson, A.S. 2002. Re-illustra-
tion and revised taxonomy for selected deep-sea
benthic foraminifers. Palaeontologia Electronica,
4:34 pp.

Jeppsson, L. and Anehus, R. 1995. A buffered formic-
acid technique for conodont extraction. Journal of
Paleontology, 69:790-794.

Jeppsson, L., Fredholm, D., and Mattiasson, B. 1985.
Acetic-acid and phosphatic fossils - a warning. Jour-
nal of Paleontology, 59:952-956.

Jernvall, J. and Selänne, L. 1999. Laser confocal micros-
copy and geographic information systems in the
study of dental morphology. Palaeontologia Electron-
ica, 2:18 pp.

Knappertsbusch, M.W. 2002. Stereographic virtual reality
representations of microfossils in light microscopy.
Palaeontologia Electronica, 5:11pp.

Lyons, P.D., Rioux, M., and Patterson, R.T. 2000. Appli-
cation of a three-dimensional color laser scanner to
paleontology: an interactive model of a juvenile Tylo-
saurus sp. Basisphenoid-Basioccipital. Palaeontolo-
gia Electronica, 3:16 pp.

Purnell, M.A. 2002. Feeding in extinct jawless heterost-
racan fishes and testing scenarios of early vertebrate
evolution. Proceedings of the Royal Society of Lon-
don, Series B, 269:83-88.

Purnell, M.A., Donoghue, P.C.J., and Aldridge, R.J.
2000. Orientation and anatomical notation in con-
odonts. Journal of Paleontology, 74:113-122.

Purnell, M.A., Williams, M., Akhurst, M., and Wilby, P.
2003. The conodont Distomodus kentuckensis: alter-
native reconstructions, a bedding plane assemblage,
and the implications for apparatus evolution.
Abstracts of the Palaeontological Association Annual
Conference, Palaeontology Newsletter, 54:81.

Purnell, M.A., Williams, M., Akhurst, M., and Wilby, P., in
prep. A partial skeleton of Distomodus kentuckyensis
(Conodonta, Vertebrata) from the Llandovery of Scot-
land. 

Reser, P.K. 1981. Precision casting of small fossils: an
update. Curator, 24:57-180.

Rose, J.J. 1983. A replication technique for scanning
electron microscopy: applications for anthropologists.
American Journal of Physical Anthropology, 62:255-
261.

Rowe, T. 1996. Coevolution of the mammalian middle
ear and neocortex. Science, 273:651-654.

Scott, D.B., Takayanagi, Y., Hasegawa, S., and T., S.
2000. Illustration and reevaluation of affinities of Neo-
gene Foraminifera described from Japan. Palaeonto-
logia Electronica, 3:41 pp.

Siveter, D.J. 1984. Casts illustrating fine ornament of a
Silurian ostracod, p. 105-122. In Donovan, D.T.,
Bate, R.H., Robinson, E., and Sheppard, L.M. (eds.),
Fossil and Recent Ostracods. Ellis Horwood, Chich-
ester.

Sylvester Bradley, P.C. 1971. The reaction of systemat-
ics to the revolution in micropalaeontology, p. 95-111.
In Heywood, V.H. (ed.), Scanning Electron Micros-
copy: Systematic and Evolutionary Applications. Aca-
demic Press for the Systematics Association,
London.

Teaford, M.F. and Oyen, O.J. 1989. Live primates and
dental replication: new problems and new tech-
niques. American Journal of Physical Anthropology,
80:73-81.

Waters, B.T. and Savage, D.E. 1971. Making duplicates
of small vertebrate fossils for teaching and research
collections. Curator, 14:123-132.



PURNELL: CASTING MICROSCOPIC DETAIL

10

APPENDIX 1

A step-by-step guide to producing red-green
anaglyph stereo images from greyscale images
using Adobe Photoshop® (tested with versions 4
upwards). To view the final image in stereo, red-
green viewers (3D glasses) are required. If red-
blue viewers are to be used, follow the instructions
below, but at step 5 set the output levels of the red
and green channels (not red and blue) to 0. 

1. Open the files for the left and right images of
the stereo pair and ensure that they are cor-
rectly oriented, with the axis of rotation (8-10°,
unless vertical exaggeration is desired)
aligned vertically. The process is easier if the
images are of the same pixel dimensions, and
it is usually helpful to give the files names that
indicate which image is left and which right (in
this example they are called Xleft.tif and
Xright.tif).

2. Taking one image first, in this case Xleft.tif, the
image for the left eye (acquired at – 4° relative
to horizontal), from the Image menu, select
Mode > RGB Color.

3. From the Image menu, select Adjust > Lev-
els (or Adjustments > Levels in Photoshop
7).

4. a. In the Levels window, from the Channel
pop-up menu, select Green. 
b. Set the Output Levels to 0 and 0. The
image should now appear purple.
c. Stay in the Levels window, and from the
Channel menu select Blue.
d. Set the Output Levels to 0 and 0. The
image should now appear red.
e. Stay in the Levels window, and from the
Channel menu select Red. If the Red chan-
nel’s histogram is truncated or skewed, adjust
the sliders accordingly to improve image con-
trast and brightness (this step is optional, but
can significantly improve the quality of the
final stereo image).
f. Click OK to close the Levels window.

5. Make the right image of the stereo pair
(Xright.tif in this example) the active window
(acquired at + 4° relative to horizontal), from
the Image menu, select Mode > RGB Color.

6. From the Image menu, select Adjust > Lev-
els (or Adjustments > Levels in Photoshop

7). Repeat steps 4a-b for the Red and Blue
channels. The image should now appear
Green. Repeat step 4e for the Green channel
(optional).

7. From the Layer menu, select Duplicate
Layer. In the Duplicate Layer window, in the
Destination, Document pop-up menu, select
the file containing the left image (in this case
Xleft.tif) and click OK.

8. Make the left image the active window (in this
case Xleft.tif). It will now have two levels
(shown in the Layers palette) the uppermost
of which will be the right image that you just
duplicated in step 7.

9. In the Layers palette, from the Layers pop-up
menu select Screen.

10. If necessary, adjust the position of the upper-
most layer to maximise the alignment of the
two images. The anaglyph stereo pair is now
complete and should look three-dimensional
when viewed using red-green viewers. The
image should be saved in the format best
suited to the purpose of the image. To avoid
loss of information through image compres-
sion and preserve the layers, which will allow
for future adjustments to be made, save as a
Photoshop format file. If the image is being
prepared for publication, a file format that
does not involve loss of information during
compression is best, probably TIFF or EPS
(not JPEG). For use on the www or in a Pow-
erpoint presentation, adjust the pixel dimen-
sions of the image downwards to a size that is
suitable (i.e., no more than 1024 x 768 for
Powerpoint), and if no further editing will be
required, save as a JPEG file, with appropri-
ate compression.
A Photoshop actions file (Anaglyph_RG.atn

for Photoshop® v. 4 or newer) is available for
download. When loaded into Photoshop®, the two
actions (LeftToRed and RightToGreen) will auto-
mate steps 2-4 for the left image and and steps 5-6
for the right image. (To load these actions, choose
Load Actions from the Actions palette menu.
Locate and select the action set file
[Anaglyph_RG.atn], then click Load). For more
details regarding actions consult Photoshop Help
or the Manual.
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APPENDIX 2

Product information, manufacturers, suppliers, 
and distributors

www.amberchemical.com: Ambersil Silicones, UK
manufacturer of RTV 913 and other rubbers; web-
site also lists distributors for other parts of the
world, and has request forms for Material Safety
Data Sheets.

www.quantumsilicones.com: Quantum Silicones,
US supplier of RTV 913 (as QM113).
www.adhesives.vantico.com: distributor for Araldite
2000 series epoxy resins; website also includes
instructions on how to obtain MSDS
www.spnhc.org: The Society for the Preservation
of Natural History Collections, including links
(under “publications”) to SPNHC Leaflet #2 Adhe-
sives and Consolidants in Geological and Paleon-
tological Applications (Elder et al. 1997).
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